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FCC statement

This device complies with Part 15 of the FCC rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference.

(2) This device must accept any interference received, including interference that may cause
undesired operation.

Class B Digital Device. This equipment has been tested and found to comply with the limits for a
Class B digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one of more of the
following measures:

□  Reorient or relocate the receiving antenna.
□  Increase the separation between the equipment and receiver.
□ Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected.
□ Consult Gateway 2000 or an experienced radio/TV technician for help.

Caution to the user: The Federal Communications Commission warns the users that changes or
modifications of the unit not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

CAUTION: DISCONNECT POWER BEFORE SERVICING.
ATTENTION: COUPER LE COURANT AVANT L'ENTRETIEN.
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Introduction

Your system contains an STB Trio 64 2MB local bus
video card, an advanced computer graphics video dis
play adapter. A hardware cursor provides additional
speed in DOS applications.

Even though the Vision extends performance beyond
the scope of other graphics technologies, it remains
VGA/VESA register-level compatible.

The card has power-saving features that support the
EPA's Energy Star program.
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To maximize the power and versatility of this card
with your applications, special enhanced drivers have
been included for:

□ Windows

□ OS/2 Presentation Manager

□ AutoCAD 386 and other AutoDesk and CAD ap
plications

□ Video Utilities

□ Windows NT.

The STB Trio 64 PCI adapter is also supported by the
VGA driver included with most software applications
available today.

Specifications

hAemory 2MB high-speed DRAM

Performance 72.5 Million WINMARKS in 1024 x 768, 256 colors at 60Hz on a P5-90
running Winbench 3.1 1

Bus 32-bit PCI local bus; 64-bit acceleration

Accelerator S3 Trio 64 (64 bit)

Resolution, color depth, vertical refresh
1280 X 1024, up to 60Hz refresh, up to 16 colors
1024 X 768, up to 75 Hz refresh, up to 256 colors
800 X 600, up to 75 Hz refresh, up to 65K colors
640 X 480, up to 75 Hz refresh, up to 16.7 million colors

Connector Standard 15-pin video

Software platform support DOS, Windows, OS/2, UNIX

Drivers Windows, AutoCAD, Windows MR, OS/2

Monitor support Standard VGA 640 x 480 analog monitors or better

Power Approx 5W

MTBF 35,000 hours



STB Trio 64 layout

Note: This User's Guide describes the STB Trio 64 2MB local bus video card. Although
Gateway 2000 ships two versions of this card, the cards function the same and have identical
specifications. Match your card to one of these illustrations, and use that as your guide during
the installation process.
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Installing your video card

Note: If your system
automatically enters
Windows, you may see
a C:\UINDOUS>

prompt after closing
Program Manager. If
so, you may skip Step
3 and continue with

Step 4.

If you purchased the video card with the computer,
you can skip this section.

To install the video card:

1. Before you remove the old card, power up the
computer. At the C:\> prompt type:

edit autoexec-bat

and press Enter. Remove all lines in the
AUTOEXEC.BAT file that refer to the old video

card and driver, save, and exit. Using this proce
dure, do the same for the CONFIG.SYS file.

2. Be sure you are in DOS. You should see a C:\>
prompt on the screen.

3. Go to the Windows directory by typing:

cdXwindows

and press Enter.

4. Type:

setup

and press Enter to start the Windows setup pro
gram.

5. Follow the prompts on the screen to change the
line labeled Display to VGA.

6. Exit the setup program. (Accept the installed VGA
driver by pressing Enter when you see the mes
sage about replacing the driver.)

7. Power down the computer. Remove the power
and video cables from the back.

8. Remove the cover according to the directions in-
the System Guide that shipped with your system.
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□

□

Important static electricity precautions!

Before handling any components or touching anything inside the
system unit, discharge your body's static electric charge by touching
a grounded surface. If the system unit is connected to a grounded
outlet, you can touch any part of the system's metal chassis.

Do not remove cards from their antistatic bags until you are ready to
install them.

When you handle a card, hold it by the edges or the metal mounting
bracket. Avoid touching components on the card or the edge con
nector that plugs into the expansion slot.

Avoid plastic, vinyl, styrofoam, and fur in your work area.

Wear a grounding wrist strap if one is available.

9. Remove the old video card according to the direc
tions in the Step-by-step Installation Guide that
shipped with your video card.

10. Remove the new video card from its antistatic bag.

11. Carefully press the card into the PCI expansion
slot. It's OK to seesaw the card end-to-end a little
to get it into the slot, but don't tilt the card side
ways. You may need to press in on the tab at the
bottom of the card bracket to keep it from catching
on the chassis. Secure the bracket to the case with
the supplied screw.

12. Reattach the video cable.

13. Power up the computer to make sure that the card
works. (If you can read the screen, the card works.)

14. If everything operates correctly, power down the
computer and close up the system.
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Configuring the system

Note: If you received
installation diskettes, the
drivers are NOT on the

System CD you may
have received. If you did
NOT receive diskettes,
reference the System CD
booklet that shipped in
the CD's jewel case for
installation instructions.

Note: If you want
to install any other
drivers, use the
down arrow key to
highlight, then the
spacebar to toggle
YES, each driver you
want to install. We

recommend that

you not install driv
ers for software you
don't use.

To get the best performance from the video card, you
must install and run the video software. If you pur
chased your system with the card, this has already
been done. However, if this card is different from the
card it replaces or if you decide to reinstall the video
software, you should follow these directions.

To set up the DOS video utilities:

1. Power up the computer; remain in DOS. If you are
in Windows, exit Windows to the C:\> prompt.

2. Insert the diskette labeled STB Trio 64 PCI Utility/
Driver into the A: drive, or insert the System CD
into the CD-ROM drive (see Note: box to left).

3. Switch to drive A: by typing:

a:

at the C:\> prompt and pressing Enter.

4. Type:

stbsetup

at the A:\> prompt and press Enter. An opening
screen appears.

5. Press Enter to begin the installation. The Installa
tion Options screen appears.

6. A screen appears showing several driver selec
tions.

7. Using the down arrow key, highlight the fourth
line:

STB POUERGRAPH PCI Utilities

and press the spacebar to toggle to YES. Press
Enter.

8. Press Enter to install the items set to YES. A screen

appears suggesting a directory name for each item.
We recommend you press Enter to accept the de
fault name.
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9. Press Enter again to confirm that you want to in
stall the software. The installation program installs
the software you selected.

10. Press Enter to return to the C:\> prompt.

Refer to the section "Using the DOS utilities" for infor
mation about using the utilities.

To install the Windows video utilities:

1.

Note: If you received
installation diskettes, the
drivers are NOT on the

System CD you may
have received. If you did
NOT receive diskettes,

reference the System CD
booklet that shipped in
the CD's jewel case for
installation instructions.

STB Vision Installation Utility

Do you want to create a Program Manager
'STB Vision' group to contain icons
that can be used to controi STB Vision?

2.

3.

Power up the computer. If you have not already
done so, follow the first six steps in the section
"Installing the video card" to set the Windows
resolution to VGA. Start Windows.

Insert video diskette labeled STB Vision for Win
dows into the A: drive, or insert the System CD into
the CD-ROM drive (see Note: box to left).

Select Run from the File menu in Program Manager.
Type a:\setup on the Command line and press Enter
or click on OK. An opening screen appears saying
that it will install the video software in the

Windows directory.

STB Vision Installation Utility

Version 1.10 Sep 20 1994
Copyright STB Systems Incorporated, 1994

STB Vision will be installed into your existing
Windows directory. Select 'OK' to continue.

Windows Directory"

I  Cancel | ReadMe | | Help ~]

4. Click on OK. The installation program installs the
drivers, then suggests a group in which to place its
icons. Click on Yes. The software creates the group
and installs several video utility icons in the group.

Click on Yes.



The SIB Vision Control Panel will now be

started so that you can select your Initial
display setting.

The Items on the STB Vision Control Panel

'Features' menu will not be available until

you have selected your initial display setting
and Windows has been restarted.

Select 'OK' to continue.

User's Guide I I

A message appears about running the STB Vision
Control Panel.

5. Click on OK. The Control Panel appears. Choose
the desired settings. For details on how to use the
Control Panel, follow the directions in the section

"Using the Windows utilities" or click on the Help
button.

[«»j File Options Window Help M

Virtual Multiple
Desktop Desktop

IBColots 256 Colors 32K Colors 64K Colors 16.8M Colors Bitd'sEye

640x480 800x600 1024x768 1280x1024

If you use OS/2 refer to the RNNT.DOC file on the
diskette labeled OS/2. This file contains general re
lease notes for OS/2, Windows NT, and AutoCad. The

procedure for installing third party video drivers for
OS/2 can be found in the OS/2 manuals.

Using the DOS utilities

MONITOR utility

The MONITOR utility allows you to easily set the
vertical refresh rates of the Trio64 video card to match

your monitor.



12 STB Trio 64 Local Bus Video Card

Note: If you need to
change the settings,
run the MONITOR

utility again and se
lect the new settings.
The new settings
overwrite the existing
settings.

To use the MONITOR menu-driven Interface:

1. If you are in Windows, exit to the C:\> prompt
and type:

cd stbutil

and press Enter. Then type:

monitor

at the C:\STBUTIL> prompt and press Enter.

2. The main program window shows several names
of monitors. Use the arrow keys to highlight your
monitor and press Enter. The utility makes the
necessary changes and retruns you to the C:\>
prompt.

If your monitor is not listed in the menu, highlight
the option CUSTOM and press Enter. From the
Refresh Rates menu, highlight each resolution that
you want to change and press Enter (see your
monitor manual for the resolution information). A

sub-menu appears that displays all the available
vertical refresh rates for the given resolution. Once
you have changed all the desired resolutions, press
FIO to update the adapter with your selections.
The MONITOR utility pauses to update the Trio 64
PCI adapter and then returns you to the C:\>
prompt.

Warning! Selecting a vertical frequency that your monitor cannot support may result in
permanent damage to your monitor. Please look at your monitor documentation and
determine the vertical frequencies the monitor is capable of displaying before using the
MONITOR utility.
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Using the Windows utilities

Control Panel

Contro

Panel

The first time you install the video software, the STB
Vision Control Panel appears automatically. After the
first time, start the Control Panel by double clicking on
its icon in the STB Vision group window.

To use the STB Vision Control Panel:

Choose a virtual desktop size before
you choose a resolution.

1. If you just installed the video software, the STB
Vision Control Panel is already open. If not, start
Windows and double click on the the STB Vision

Control Panel icon. (By default it is in the STB
Vision group.) The Control Panel window appears.

STB Vision Control Panel

Options Featiir^s Help
□

"Colors

O 16

256

O :vnivi

O 65535

O 16.8 M

~Vir^l Desktop Size"
% 640x480

O 800x600

O1024x768

O 1200x1024

O 1000x1200

Resolution

640x480

O 000x000

O 1024x700

O 1200x1024

O 1000x1200

OKI

Cancel

Exit

Saved Settings'

Save Setting Remove Setting I

"Font Size"

% Normal

O laf<|e

Help

ReadMe

Enter names for your favorite
combinations of settings here.
(Click on Save Setting after you
name each.) You can choose
from the list when you want to
change settings.

Note: Each appli
cation comes with
an extensive Help
file. To access the
file, click on the
Help button in the
dialog box.
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2. Click on the desired settings. The Control Panel
automatically grays out choices that are not avail
able.

Colors refers to the number of colors available to

appear on the screen.

Note: You can

also change the
color depth by
double clicking on
a color icon in the

STB Vision group.

1G Colors

Color icons

256 Colors 32K Colors 84K Colors 1G.8M Colors

Virtual Desktop Size means that the desktop is
larger than what shows on the screen. You move
the view on the screen by moving the pointer
against the edge of the screen.

Resolution tells how many pixels appear on the
screen. The numbers are pixels across times pixels
down. The higher the resolution, the smoother the
image on the screen.

If you set a high resolution, you can switch to a
lower resolution later without restarting Windows.

Note: You can

also change reso
lution by double
clicking on a reso
lution icon in the

STB Vision group.

840x480 800x800 1024x768 1280x1024

Resolution Icons

Font Size refers to the size of menu and icon la

bels. If you choose a high resolution, you should
choose the large font size for readability.

3. If you wish, you can name a combination of set
tings. Choose the settings and type a name in the
Box labeled Saved Settings. If you want to name
more than one combination, click on Save Set

ting. Now make another combination and name
it. Repeat as desired.

You can activate any of your saved combinations
by selecting its name from the drop-down list.
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3. Click on OK. A message appears about restarting
Windows. Since your changes don't take effect
unless you restart Windows, click on OK.

You can set several options that affect how the Control
Panel itself interacts with the system.

To set Control Panel options:

1. Choose Control Panel... from the Options menu in
the STB Vision Control Panel.

ution —

411x41)11

i UlX4xnill

t  1200x10

1li0llxl2

The STB Vision Control Panel Options dialog box
appears.

STB Vision Control Panel Options

Ctrl+Alt+C
lOKi

Cancel

Window Options"

^ Desktop icon

□ Always on top
"Prompts

H Prompt on Windows restart
S Prompt on STB Vision Exit
S Prompt on no 'Load='

2. Choose the settings you desire.

Desktop icon controls whether an icon appears on the
desktop when you minimize the Control Panel. When
the desktop icon is disabled, the Control Panel does
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not appear in Task Manager's window list nor in the
Alt+Tab window list. To activate the Control Panel in

this situation, use the hotkey (if you have assigned
one), or select the Control Panel icon in the STB Vision
group window, or use the File, Run menu item to di
rectly run STBVISN.EXE.

Always on Top controls whether the Control Panel
always appears on top of most other windows on the
desktop. If this item is not selected, other windows are
allowed to overlap the Control Panel.

The Hotkey edit box allows you to assign a hotkey
that can be used to invoke the Control Panel directly.
Pressing the hotkey sequence when the Control Panel
is minimized or hidden restores the Control Panel.

Pressing the hotkey sequence when the Control Panel
is visible minimizes or hides the Control Panel.

To specify the hotkey key sequence, click in the HotKey
edit box, then press any combination of modifier or
prefix keys (Alt, Ctrl, and Shift) followed by a termi
nating key (A-Z, 0-9, or F1-F12). If you attempt to
assign a hotkey that conflicts with another STB Vision
hotkey, an error box appears when you select OK.
Either assign a non-conflicting hotkey or delete the
conflicting hotkey. Delete a hotkey by clicking in the
HotKey edit box and then pressing backspace or de
lete.

Prompt on Windows restart controls whether the Con
trol Panel prompts you after you make a selection
which requires Windows to restart. If this item is not
selected, the Control Panel restarts Windows without

prompting you.

Prompt on STB Vision Exit controls whether the Con
trol Panel prompts you to confirm that you wish to
exit the Control Panel. Once you exit the Control Panel
the STB Vision advanced features and hotkeys are not
available until you run the Control Panel again.
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Prompt on no ̂ 03(1=' controls whether the Control
Panel prompts you when it detects that STBVISN.EXE
is not present in the WlN.INl Load line. If this item is
selected, the Control Panel prompts you when it de
tects this situation and asks if you wish to configure
your system to automatically load the Control Panel
every time Windows starts.

3. Click on OK when you are finished.

If your screen is scrambled when you return to Win
dows, you set a frequency too high for your monitor.
Press Alt+E4, then press Enter to exit Windows. When
you are in DOS, go to the Windows directory and run
Setup to run Setup, type:

cdNwindows

at the C:\> prompt and press Enter; then, type:

setup

at the C:\WlNDOWS> prompt and press Enter.
Change the Display line to VGA (follow the prompts).
Return to Windows and try another setting.

Icon toolbar

Note: Each appli
cation comes with

an extensive Help
file. To access the

file, click on the
Help button in the
dialog box.

1. Choose Icon Toolbar... from the Options menu in
the STB Vision Control Panel. The STB Vision Icon

Toolbar Options dialog box appears.

bdf
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Monitor options

The Icon Toolbar dialog box allows you to customize
a toolbar by removing or adding icons. For more de
tailed information on customizing a toolbar, click on
the Help button.

Note: Each appli
cation comes with

an extensive Help
file. To access the

file, click on the
Help button in the
dialog box.

1. Choose Montior... from the Options menu in the
STB Vision Control Panel. The STB Vision Moni

tor Options dialog box appears.

liatcwny 200U Vivitron 1572

Reset I Klq

The Monitor Options dialog box performs the same
function as the DOS Monitor Utility: it allows you to
select your monitor's settings. Use the Monitor Selec
tion drop down box to find your monitor. Scroll through
the list until you find your monitor; highlight the
appropriate option.

The standard refresh rates for each resolution are found

in the Refresh Rate Limits section of the dialog box. Set
the resolution and refresh rates using the appropriate
drop down box. Scroll through the choices and select
the correct option for your monitor. The refresh rates
can be altered, but check your monitor manuals to
make sure you don't exceed the limits.

Make sure to click on the Test button when manu

ally adjusting the screen refresh rates.
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The Image Centering options allow you to adjust the
image that appears on the screen. Simply click on the
appropriate arrows to move the image to the position
you prefer. Clicking on Reset sets the screen back to
default centering.

The Dialog Box Centering options allow you to choose
where any Window's dialog boxes appear on the screen
when invoked.

For more information about the Monitor Options dia
log box, click on the Help button.
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Virtual desktop

Virtual

Desktop

Double click on the virtual desktop icon in the STB
Vision group to toggle between seeing part of a virtual
desktop at the resolution you set and raising the reso
lution so you can see the entire desktop.

Bird's Eye window

Bird s Eye

The Bird's Eye window shows a reduced representa
tion of your entire virtual desktop. You can click within
the Bird's Eye window to pan to a selected area of the
virtual desktop. You can also use the Bird's Eye win
dow to get a quick overview of where your windows
are located on your virtual desktop.

Bird's Eye window shown in
Fast draw mode.

Click here to reach the

Options box.

Title bar.

Windows (yours
will be different).

(Fancy wallpaper not
shown in Fast draw).

Icons.

Note: Each appli
cation connes with

an extensive Help
file. To access the

file, click on the
Help button in the
dialog box.

STB Vision Bird's Eye
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Configure the Bird's Eye window from Bird's Eye
Options dialog box, available in the Options menu in
the STB Vision Control Panel and the Control menu in

the Bird's Eye window.

STB Vision Bird's Eye Options

"Mode

O Popup

® Persistent

O Off

-HotKey-

Ctrl+Alt+B
OK

"Window Options'

^ Title bar

IS Desktop icon

S Always on top

□ jFast drawi

"Default Size

O None

^1/4 screen
O 1/8 screen
O 1/16 screen
O 1/32 screen

Cancel

In Popup mode the Bird's Eye window pops up cen
tered on the pointer location when it is invoked and it
minimizes itself when you click in it to pan to a new
location in the virtual desktop. In Persistent mode, the
window also pops up centered on the pointer location,
but it does not minimize itself when you click in it to
pan to a new location. It stays in place, ready for you to
click and pan again.

Fast draw accelerates the drawing of the Bird's Eye
window client area by using an approximate repre
sentation of the virtual desktop showing open win
dows as rectangles. Without Fast draw the representa
tion of the virtual desktop is more detailed, but it takes
longer to draw.

Title bar controls whether the Bird's Eye window has
a title bar.

Desktop icon controls whether an icon appears on the
desktop when the Bird's Eye window is minimized. If
this item is not selected, the icon does not appear on
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the desktop when you minimize the Bird's Eye win
dow, and the item does not appear in Task Manager's
window list or in the Alt+Tab window list. To activate

the Bird's Eye window in this situation, use the hotkey
(if you have assigned one), or select Bird's Eye from
the STB Control Panel Features menu.

Always on top controls whether the Bird's Eye win
dow always appears on top of most other windows on
your desktop. If this item is not selected, other win
dows can overlap the Bird's Eye window.

The Hotkey edit box allows you to assign a hotkey to
directly invoke the Bird's Eye window. Pressing the
hotkey sequence when the window is minimized or
hidden makes it visible. Pressing the hotkey sequence
when the Bird's Eye window is visible minimizes or
hides the Bird's Eye window.

To specify the hotkey key sequence, click in the HotKey
edit box, then press any combination of modifier or
prefix keys (Alt, Ctrl, and Shift) followed by a termi
nating key (A-Z, 0-9, or F1-F12). If you attempt to
assign a hotkey that conflicts with another STB Vision
hotkey, an error box appears when you select OK.
Either assign a non-conflicting hotkey or delete the
conflicting hotkey. Delete a hotkey by clicking in in
the HotKey edit box and then pressing backspace or
delete.

The Default Size group box allows you to select the
default window size that the Bird's Eye window uses
when it is invoked. If you specify None, the Bird's Eye
window defaults to the size in use the last time you
used the Bird's Eye window.
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The zoom function places a window on the screen that
shows an enlarged view of the region immediately
aroung the pointer.

Zoom

Click here to reach the Zoom Options
dialog box.

This is the pixel the pointer is on.

Note the status area showing pointer
location, the color setting of the pixel the

pointer is on, and the magnification.

Typical Zoom window, showing its own upper right corner.

5TB Vision Zoom

Position

531 .284

Color Zoom

0  ,0 ,128 |1

To set options for the Zoom window, click on the little
square in the upper left corner of the window to open
the control menu and choose STB Zoom Options... from
the menu. The zoom options dialog box appears.

Note: Each appli
cation comes with

an extensive Help
file. To access the

file, click on the
Help button in the
dialog box.

Mode "Position Type~ "Window Options

® Dynamic ® Absolute H Title bar

O Static O Relative ^ Desktop Icon

O Off O Client □ Always on top
Default Zoom" "Default Size ^ HIgbllgbt
® None ® None □ Grid

O 2X O 1/d screen ^ Status

O dX O 1/8 screen HotKey

O GX O 1/16 screen
Ctrl+Alt+Z

O 8X O 1/32 screen

These are the options:

The Mode group box controls whether the Zoom win
dow is in dynamic mode, in static mode, or off.
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Dynamic enables the Zoom window feature in dy
namic mode. When the Zoom window is in dynamic
mode, the contents of the Zoom window client area
are dynamically updated as the mouse cursor moves
across the display.

"Mode "Position Type"

$ Dynamic $ Ahsoiute

0 Static 0 Reiative

OOff 0 Client

"Default Zoom' "Default Size

® None ® None

0 2X 0 1/4 screen

0 4X 0 1/8 screen r

Oex 0 1/16 screen

0 8X 0 1/32 screen

STB Vision Zoom Options

lEI Title bar

M Desktop icon

D Always on top

lEI Highlight

□ Grid

M Status

HotKey-

Ctrl+Alt+Z

OK

Cancel

Help I

Static means the contents of the Zoom window don't
change as you move the pointer. To use this mode,
click in the client area of the Zoom window. The pointer
changes to a rectangle. Move the rectangle to the area
you want to zoom in on, then click again.

Off disables the Zoom window feature. When the
Zoom window feature is off, the Zoom window is not
available and cannot be invoked.

The selections in the Position Type group box control
the type of position information displayed in the sta
tus area. (Enable or disable the status area in the Win
dow Options group box, described later.)

Absolute position is relative to the upper left corner of
the display, considered to be at x,y position 0,0.

Relative position is relative to a pixel position you
specify. Set the relative position origin (the 0,0 posi-
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tion) by pressing the Ctrl key with the pointer point
ing at the desired pixel position. It is not necessary to
click when you press Ctrl, but the Zoom window must
be the active window.

Client position is relative to the upper left corner of
the client area of the window the pointer is currently
over. The upper left corner of the client area is consid
ered to be at x,y position 0,0.

The Window Options group box controls the appear
ance and behavior of the Zoom window.

Title bar controls whether or not the Zoom window

has a title bar.

S D Vision Zoom

ZoomPosition Color

531 .29A

Desktop icon controls whether or not an icon appears
on the desktop when the Zoom window is minimized.
When the desktop icon is disabled, the Zoom window
does not appear in Task Manager's window list or in
the Alt+Tab window list. To activate the Zoom win

dow in this situation, use the hotkey (if you have
assigned one), or select Zoom from the STB Control
Panel Features menu.

Always on top controls whether the Zoom window
stays on top of most other windows on your desktop.

Highlight controls whether the pixel at the center of
the selected area is highlighted in the Zoom window
client area. If this item is selected, the pixel is high
lighted with a box of contrasting color drawn around
it. If this item is not selected, the pixel is not high
lighted.

Grid controls whether a grid is drawn between adja
cent pixels in the Zoom window client area.

Status controls whether the status area is displayed at
the bottom of the Zoom window client area. If this

item is selected, a status area showing the position and
color of the pixel at the center of the current selected
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area and the current zoom factor appears at the bot
tom of the Zoom window client area.

The Default Zoom group box allows you to select the
default zoom factor that the Zoom window will use

every time it is invoked. If you specify None, then the
Zoom window uses the factor in use the last time you
used the Zoom window.

The Default Size group box allows you to select the
default window size that the Zoom window uses when

it is invoked. If you specify None, the Zoom window
defaults to the size in use the last time you used the
Zoom window.

The Hotkey edit box allows you to assign a hotkey to
directly invoke the Zoom window. Pressing the hotkey
sequence when the Zoom window is minimized or
hidden restores the Zoom window. Pressing the hotkey
sequence when the Zoom window is visible mini
mizes or hides the window. To specify the hotkey key
sequence, click in the HotKey edit box, then press any
combination of modifier or prefix keys (Alt, Ctrl, and
Shift) followed by a terminating key (A-Z, 0-9, or Fl-
F12). If you attempt to assign a hotkey that conflicts
with another STB Vision hotkey, an error box appears
when you select OK. Either assign a non-conflicting
hotkey or delete the conflicting hotkey. Delete a hotkey
by clicking in in the HotKey edit box and then press
ing backspace or delete.

Multiple Desktops

Multiple
Desktop

Multiple desktops are an alternative approach to the
virtual desktop for providing more screen "real-es
tate" on which to run your applications. Multiple desk
tops make it easier for you to organize your work by
having different groups of applications run on differ
ent desktops. It's quick and easy to switch among the
desktops and the applications that reside on them.
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Note: Each appli
cation comes with

an extensive Help
file. To access the

file, click on the
Help button in the
dialog box.

Multiple desktops are like having more than one dis
play, only one of which can be seen at a time.

Configuring your multiple desktops

Before you use the Multiple Desktops Feature, you
should configure some desktops. In the STB Vision
Control Panel select Multiple Desktop... from the Op
tions menu, then specify your configuration and de
fine your desktops. Be sure to name and save each
desktop as you define it by clicking on the Save button
before you configure the next desktop.

Manager HotKey"

I Ctrl+Alt+D

I Shell stay with me

"Window Options"

S Desktop icon

□ Always on top

I  OK I

Type a name here
and click on Save-

before you start
the next desktop.

"Desktops"

pHotKey"

"Saved Desktops"

"-Main Desktop

Background rResolutlon"

(Default) I ® Default
O nied O Centered O 640x480

O 800x600

O1024x768

O 1280x1024

O 1000x1200

Mode controls whether the Multiple Desktop Feature
is on or off. When the Multiple Desktop Feature is on,
you can use your assigned hotkeys or the Multiple
Desktop Manager window to switch between desk
tops and move windows from desktop to desktop. If
multiple desktops are in use when you shut off the
Multiple Desktop Feature, all windows on all desk
tops are brought to the current desktop, and the pat
tern and wallpaper that were active when the Mul
tiple Desktop Feature was started are restored.



Note: You can also reach

this dialog box from the
control menu (in the very
upper left corner) of the
Multiple Desktop Manager
window.

Manager HotKey

I Ctrl+Alt+D

"Window Options"

^ Desktop icon

G Aiways on top

Sliell stay witli me

"Desktops

r HotKey ~

"Saved Desktops"

Main Desktop

"Background

(Default) I
0 ViiKii O Centered

"Ftesolution

® Default

O BdOxdBO

O 800x600

O1021x768

O \ 2mmo2A

O HitlOxiaOH

The Hotkey edit box allows you to assign a hotkey to
directly invoke the Multiple Desktop Manager win
dow. Pressing the hotkey sequence when the window
is minimized or hidden restores it. Pressing the hotkey
sequence when the Multiple Desktop Manager win
dow is visible minimizes or hides it. Specify the hotkey
key sequence by clicking in the HotKey edit box and
then pressing the desired combination of modifier or
prefix keys (Alt, Ctrl, and Shift) followed by a termi
nating key (A-Z, 0-9, or F1-F12). If you attempt to
assign a hotkey that conflicts with another STB Vision
hotkey, an error box appears when you select OK.
Assign a non-conflicting hotkey or delete the conflict
ing hotkey. Delete a hotkey by clicking in the hotkey
edit box and pressing backspace or delete.

The Window Options group box controls the appear
ance and behavior of the Multiple Desktop Manager
window. Desktop icon controls whether an icon ap
pears on the desktop when the Multiple Desktop Man
ager window is minimized. When the icon is disabled,
the Multiple Desktop Manager window does not ap
pear in the Task Manager's window list or in the
Alt+Tab window list. To activate the Multiple Desk
top Manager window in this situation, use the hotkey
(if you assigned one), or select Multiple Desktop from
the STB Control Panel Features menu.
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Always on top controls whether or not the Multiple
Desktop Manager window always appears on top of
most other windows on your desktop.

Shell stay with me controls whether or not your Win
dows shell is automatically assigned the Stay with me
attribute, causing the shell to follow you from desktop
to desktop as you switch between different desktops.
(The usual Windows shell is Program Manager.)

The Desktops group box allows the attributes of your
different desktops to be defined, saved, recalled, and
removed. The desktop attributes consist of the desk
top name, a hotkey used to switch to the desktop, a
bitmap or pattern used as the wallpaper on the desk
top, and the resolution to use on the desktop.

The Hotkey edit box allows you to assign a hotkey
that can be used to directly switch to a desktop. To
specify a hotkey key sequence, click in the HotKey
edit box, then press any combination of modifier or
prefix keys (Alt, Ctrl, and Shift) followed by a termi
nating key (A-Z, 0-9, or F1-F12). If you attempt to
assign a hotkey that conflicts with another STB Vision
hotkey, an error box appears when you select OK.
Either assign a non-conflicting hotkey or delete the
conflicting hotkey. Delete a hotkey by clicking in in
the HotKey edit box and pressing backspace or delete.

The Background group box allows you to select a
bitmap (BMP) file or pattern to be used as the desktop
background. Select [Default] to use the Pattern and
Wallpaper specified in the Windows Desktop Control
Panel. Select [None] to use the Desktop screen element
color specified with the Colors Control Panel as the
background. The listed bitmap files are those found in
your Windows directory, but you can enter a path to
any bitmap file on your system. The listed patterns are
those found in the CONTROL.INI file.

The Resolution group box allows you to select the
default resolution at which the desktop runs. If you
select a resolution other than Default, a dynamic reso-
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lution switch occurs (if necessary) when you switch to
this desktop. This feature works in concert with the
Virtual Desktop Feature. If a virtual desktop display
setting is not active, or if the selected resolution is
higher than the virtual desktop display setting, the
dynamic resolution switch does not occur when you
switch to the desktop.

The Saved Desktops group box allows you to save,
recall, and remove desktops by name. You can save as
many as ten desktops at a time. To save a desktop,
choose the desired hotkey, background, and resolu
tion, then type a name into the Saved Desktops list box,
then click on Save. Changes to saved settings are made
when you select Save and Remove; you do not discard
saved desktops changes by selecting Cancel.

The Multiple Desktop Manager

The Multiple Desktop Manager is where you switch
desktops, move windows from another desktop onto
the current desktop, switch to a specific window on
another desktop, and control the Stay with me at
tribute of individual windows.

The Multiple Desktop Manager window displays a
list of your active desktops and the windows that

Click here once and -

chooee STB Multiple
Desktop Options to
acceee> the Options
dialog box.

Ooubia clicking on a

desktop item is the
same as clicking on

Switch To.

Ooubie clicking on a

window item is the

same as to^^lin^

Stay with me.

STB Vision Multiple Desktop Manager

Main Desktop <current>

Exit Windows

Controi Panei

Snagit
STB Vision Control Panei

»/ Program Manager

Switch To]
jMer^ie^J

Bdng Here

Stay With Me
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reside on each desktop. The current desktop is indi
cated by <current> after its name. The windows on a
desktop are displayed immediately below that desk
top in the list. Windows with the Stay with me at
tribute are indicated by "»" displayed left of their
names. Select a desktop or window to operate on by
clicking on the desired item, then click an appropriate
button. You can double click on a window item in the

list to toggle the Stay with me attribute.

Switch To switches to the highlighted desktop.

Merge moves all of the windows from the highlighted
desktop to the current desktop.

Bring Here moves the highlighted window to the cur
rent desktop.

Stay With Me toggles the Stay with me attribute for
the highlighted item.

Switching from one desktop to another

You can switch between desktops by using hotkeys
you assign in the Multiple Desktop Options dialog
box or by using the Multiple Desktop Manager. You
can also use the STBVISN.EXE command line interface

to switch desktops.

Command line options

You can choose the settings in the STB Vision Control
Panel by entering them as parameters to STBVISN.EXE
on a command line such as the one in the File, Run

menu item, or in the Properties dialog box of an icon.
For details, search for Command line in the help file of
any STB window by clicking on the Help button. You
can see examples of command lines by clicking on any
STB icon and pressing Alt+Enter.
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